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(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home
electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.
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“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)’” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact Information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/

© 2022 Renesas Electronics Corporation. All rights reserved.



How to Use This Manual

This manual describes the role of the CS+ integrated development environment for developing applications and sys-
tems for RH850 family, RX family, and RL78 family, and provides an outline of its features.

CS+ is an integrated development environment (IDE) for RH850 family, RX family, and RL78 family, integrating the nec-
essary tools for the development phase of software (e.g. design, implementation, and debugging) into a single platform.

By providing an integrated environment, it is possible to perform all development using just this product, without the
need to use many different tools separately.

Readers

Purpose

Organization

How to Read This Manual

Conventions

This manual is intended for users who wish to understand the functions of the CS+ and
design software and hardware application systems.

This manual is intended to give users an understanding of the functions of the CS+ to use
for reference in developing the hardware or software of systems using these devices.

This manual can be broadly divided into the following units.

1.GENERAL

2.FUNCTIONS

A.WINDOW REFERENCE

B.GLOSSARY

C.HOW THE MANUALS ARE ORGANIZED
D.INPUT CONVENTIONS

E.USING AN EXTERNAL BUILD TOOL
F.SHORTCUT KEYS

It is assumed that the readers of this manual have general knowledge of electricity, logic
circuits, and microcontrollers.

Data significance: Higher digits on the left and lower digits on the right
Active low representation: XXX (overscore over pin or signal name)

Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention

Remarks: Supplementary information

Numeric representation: Decimal ... XXXX

Hexadecimal ... OxXXXX
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CS+V8.08.00 1. GENERAL

1. GENERAL

This chapter describes the role of the CS+ integrated development environment for developing applications and sys-
tems for the microcontrollers (RH850, RX, and RL78), and provides an outline of its features.

1.1 Introduction

CS+ is an integrated development environment (IDE)NOte for the microcontrollers.

By integrating the necessary tools for each development phase, it is possible to perform all phases in software develop-
ment using just this product, without the need to use many different tools separately. Emphasis is placed on making the
tools work together, improving development efficiency in many different situations. As an example, the output from the
design phase is automatically reflected in the debug phase.

CS+ also has an update feature to automatically obtain this product upgrades via the network, making it simple to main-
tain the environment required for software development (free downloadable tools excluded).

Note An integrated development environment is a development environment integrating the necessary tools
for all phases of software development, including preparation, design/implementation, and debugging,
into a single platform framework.

Remark In addition to CS+, emulators and on-chip debugging emulators (emulators for microcontrollers with on-
chip debugging facilities built in) are provided, as well as a real-time OS package (for developing systems
using real-time OS), making a wide range of development possible.

1.2 Features

CS+'s features are shown below.

(1) Project management
Manage project information, including source-file structure, build options, and settings for connecting to the debug
tool.

(2) Design
The pin assignment function makes it possible to output reports called "device pin list" and "device top view" as
files, by inputting the pin-configuration status of the microcontroller.
The code generation function can output source code (device driver programs) corresponding to peripheral func-
tions provided by the microcontroller (e.g. systems, ports, and interrupt) by selecting and entering the information
required for control in the CS+ panels.

(3) Coding
A tree view of the files included in the project appears in a CS+ panel, and the files can be edited by linking an edi-
tor to CS+.

(4) Build

You can configure optimization and other build options in the CS+ panels, enabling you to create efficient load
module files and a library file.

Remark It is also possible to link to an external build tool and use it instead of the build tool provided by CS+
(see "E. USING AN EXTERNAL BUILD TOOL").

(5) Debug
You can display your debugging tool's connection settings and debugging information in CS+ panels. There are
also many methods for executing programs, enabling you to debug your programs efficiently.

(6) Analysis
You can analyze information while the program is executing, and display information about the functions and vari-
ables.

(7) Updates
Communicate with the update server to get the latest version of this product.

R20UT5134EJ0100 Rev.1.00 RENESAS Page 7 of 331
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CS+V8.08.00 1. GENERAL

1.3 System Configuration

An example of the system configuration is shown below.

Figure 1.1 System Configuration

—Host machine
— CS+

Design tools/Build tools, etc.

Supported target environments
T Simulator “

— Supported target environments —*

Emulator

— Target system
Remark The emulator that can be connected differs depending on the microcontroller used in the project.
See "CS+ Integrated Development Environment User’s Manual: Debug Tool" for details.

R20UT5134EJ0100 Rev.1.00 RENESAS Page 8 of 331
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CS+V8.08.00 1. GENERAL

1.4 Operating Environment

Below are the system requirements for this product.

(1) Hardware environment
Processor and main memory that can comfortably run the software described in the software environment
Display: Resolution at least 1,024 x 768
Interface: USB 2.0

(2) Software environment

- Windows 8.1 (64-bit OS)

- Windows 10 (64-bit OS)

- Windows 11

- Microsoft .NET Framework 4.6.2

- Microsoft Visual C++ 2015 Redistributable Update 3

- Online help: Edge, Internet Explorer, Chrome, or Firefox (The latest version is recommended)
(3) Supported target environments

- IECUBE [RL78]

- IE850A [RH850]

- Full-spec emulator [RH850]

- E1 [RH850][RX][RL78]

- E2 emulator [RH850][RX][RL78]

- E2 emulator Lite [RX][RL78]

- E20 [RH850][RX][RL78]

- EZ Emulator [RX][RL78]

- COM Port[RL78]

- Simulator

R20UT5134EJ0100 Rev.1.00 RENESAS Page 9 of 331
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CS+V8.08.00 2. FUNCTIONS

2. FUNCTIONS

This chapter covers the basic operations of CS+ and the procedure of build using CS+.

2.1 Overview

The procedure starting from the startup of CS+, creating and building projects, and up to saving projects is shown as fol-
lows.

(1) Start CS+
Start CS+ (see "2.2 Start CS+").

(2) Create or load a project
Create a new project, or load an existing one (see "2.3 Create a Project" and "2.4 Manipulate a Project").

(3) Set the build tool version
Set the build tool version (see "2.5 Change the Build Tool Version").

(4) Set build target files
Add or remove build target files and update the dependencies (see "2.6 Set Build Target Files").

(5) Set build options
Set the options for the build tool.

Remark See "CS+ Integrated Development Environment User’s Manual: Build Tool Operation" for details about
setting build options.

(6) Run a build
Run a build after making related settings as required (see "2.7 Make Settings for Build Operations" and "2.8 Run
a Build").

Remark If there are any commands you wish to run before or after the build process, on the build tool's
Property panel, from the [Common Options] tab, in the [Others] category, set the [Commands exe-
cuted before build processing] and [Commands executed after build processing] properties.

If there are any commands you wish to run before or after the build process at the file level, you can
set them from the [Individual Compile Options] tab (for a C source file) and [Individual Assemble
Options] tab (for an assembly source file).

(7) Save the project
Save the setting contents of the project to the project file (see "2.9 Save the Project File").
In addition to the above, the following operations are possible.
- Changing the window layout (see "2.10 Change the Window Layout")
- Accelerating the startup time of CS+ (see "2.11 Accelerate the Startup Time of CS+")

- Manipulating CS+ on the command line (see "2.12 Manipulate CS+ on the Command Line")

R20UT5134EJ0100 Rev.1.00 RENESAS Page 10 of 331
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CS+V8.08.00 2. FUNCTIONS

2.2 Start CS+

When CS+ is installed and started for the first time, select Windows [Start] menu >> [Programs] >> [Renesas Electron-
ics CS+] >> [CS+ for CC (RL78,RX,RH850)].

Remark In Windows 8.1, select [CS+ for CC (RL78,RX,RH850)] on the start screen.
In Windows 10, select Windows [Start] menu >> [All apps] >> [Renesas Electronics CS+] >> [CS+ for CC
(RL78,RX,RH850)].

The following Main window will be opened.

Figure 2.1 Main Window
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On the second and subsequent occasions, you can startup CS+ from the icon in the task tray when the rapid start (see
"2.11.1 Use rapid start") is enabled.

More than one "CS+ for CC" can be started simultaneously. However, since the setting information (customization of
panel layout or menus) is common, the setting information of the CS+ for CC that ended last is held.

The extension of project files of "CS+ for CC" and "CS+ for CA,CX" is common. When a project file is double-clicked,
CS+ detects its contents and then starts the suitable product and load the project. If an attempt is made to open a project
of "CS+ for CA,CX" after "CS+ for CC" has been started, the following Message dialog box is opened.

R20UT5134EJ0100 Rev.1.00 RENESAS Page 11 of 331
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Figure 2.2  Message Dialog Box

Question(QO202004)

a— FaCACH kg i niot & projecd far the C5+far CC.
ﬂ Do you want to reopen this project by the proper C5+ and dosa this product?

F [No)is s=lected, resiore anly file structurs on this praduct and you can not build
and debug the project.

[ g J[ Mo |[ cones [[ b |

Click [Yes] to end "CS+ for CC" and start "CS+ for CA,CX" to load the project. Click [No] to load the project by "CS+ for

CC" without changing the CS+. Click [Cancel] to halt loading. If [No] is clicked, though a project is loaded by "CS+ for
CC", it cannot be built or debugged.

Remark The plug-ins other than the build tool, debug tool, and Editor panel are disabled by default (the disabled

plug-ins are displayed in the Output panel).

Enable desired plug-ins on the [Additional Function] tab in the Plug-in Manager dialog box opened by
selecting [Tool] menu >> [Plug-in Setting...].

To reflect the new settings, restart CS+.

R20UT5134EJ0100 Rev.1.00 RENESAS Page 12 of 331
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2.3 Create a Project

A project is managed by CS+ as the unit for application system development.
CS+ saves settings information used in the project such as the microcontroller, build tool, and source files, to the project
file (*.mtpj) and references it.

Remark The following lists types of project files other than *.mtpj.
Extension Description
*.mtud Environment-dependent information-saving file

This file is for saving information that does not affect the generation of object files
but changes in succession according to the environment you are using or the
operations in each project or in each project per user.

It is recommended that environment-dependent information-saving files not be
registered with the source management tools.

For details, see 2.9.5 Save and share environment-dependent information-sav-
ing files.

*.rcpe Renesas common project file (for porting a project to the e? studio)

(1) Project tree organization and detailed settings
The project's settings are made on the Project Tree panel.

R20UT5134EJ0100 Rev.1.00 RENESAS Page 13 of 331
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Figure 2.3  Project Tree Panel
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On the project tree, project components are displayed as the nodes below in a tree view.

If you select each component (node or file), its detailed information (properties) is displayed in the Property panel
and you can change its settings.

You can also make project settings from the context menu for each component (node or file).

Node Explanation

Project name (Project) The project's name.
(Hereafter referred to as "Project node")

Microcontroller name (Microcontroller) The microcontroller used in the project.
(Hereafter referred to as "Microcontroller node")

Boot Loader (Configuration Tool for Multi-core The node for setting application projects which configure a

node) [RH850] project for multi-core.
(Hereafter referred to as "Configuration Tool for | Note that this node is shown when the project type is a boot
Multi-core node") loader project.

R20UT5134EJ0100 Rev.1.00 -zENESAS Page 14 of 331
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CS+V8.08.00 2. FUNCTIONS

Node Explanation

Design Tool name (Design Tool) The design tool (pin configurator, code generator, smart con-
(Hereafter referred to as "Design Tool node") figurator [RX][RL78], etc.) used.

Note that Code Generator (Design Tool) node is not shown
when the project type is a debug-dedicated project.

Build tool name (Build tool) The build tool (compiler, assembler, etc.) used.
(Hereafter referred to as "Build Tool node") When the project type is a debug-dedicated project, "None"
is shown as build tool name.

Debug tool name (Debug Tool) The debug tool (in-circuit emulator, simulator, etc.) used.
(Hereafter referred to as "Debug Tool node")

Program Analyzer (Analyze Tool) The analyze tool used.
(Hereafter referred to as "Analyze Tool node") Note that this node is not shown when the project type is a
debug-dedicated project.

File Files registered to the project are displayed directly below
(Hereafter referred to as "File node") the File node.
Download files This is a node for adding download files to the project.

(Hereafter referred to as "Download files node") | Note that this node is shown only when the project type is a
debug-dedicated project.

Build tool generated files This node is created during a build. Files created by the
(Hereafter referred to as "Build tool generated build tools are displayed directly below the node (except for
files node") object files).

Note that this node is not shown when the project type is a
debug-dedicated project.

Startup [RL78] This is a node for adding other than standard startup files to
(Hereafter referred to as "Startup node") the project. This node is always shown under the File node.
Note that this node is not shown when the project type is a
debug-dedicated project.

Category name These user-defined categories are used to classify files into
(Hereafter referred to as "Category node") modules.
Subproject name (Subproject) Subprojects added to the project.
(Hereafter referred to as "Subproject node") For subprojects, see "(2) Projects and subprojects”.
Remark 1. Only the tools corresponding to the microcontroller in use are shown.
Remark 2. When more than one component are selected, only the tab that is common to all the components is
displayed.
When more than one file are selected and their common properties are different, that field is left
blank.

Remark 3. See "E. USING AN EXTERNAL BUILD TOOL" for details on a debug-dedicated project.

(2) Projects and subprojects
Projects can have subprojects added to the level beneath them.
The subproject's settings information is saved to a subproject file (*.mtsp).
Subprojects, for example, are used in the following ways.

- When also creating a project to create library files used in the project, create a project to create library files as a
subproject.

- When developing the same application system for different microcontrollers, create the projects that differ for
the microcontroller as subprojects.

When subprojects are added, this manual call the project "main project", as opposed to its subprojects. "Project"
is a common term for the main project and subprojects.
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Figure 2.4  Project Tree Panel (When Subprojects Added)
Project Tree
: @ 3 @&
- PR
% R5F5311114¢FL (Microcontrodler)
!'f'--'ﬂ Code Generator (Design Tool)
A, CC-RX (Build Tool) Main project
{2, R Simulator (Debug Tool)
be ¢ Fregram Analyzer (Analyze Tool)
w3 File
=L 1% sub (Subproject)
i RSFSEINACKFE (Microcontroller)
Project

-, CC-RX (Build Tool)
-~ R¥ Simulator (Debug Tool)
(¥ erogram Analyzer (Analyze Tool)
4l :‘i:- Fils
% sub2 (Subproject)
I RSESEINACKFE (Microcontroller)
A CC-RX (Build Tool)
e RX Simulator (Debug Tool)
' program Analyzer (Analyze Tool)
41- P File

Subproject

Subproject

In addition, project settings and the settings for subprojects added to a project are independent and have no effect
on each other. When making the same settings between the main project and subprojects, or between differing
subprojects, select multiple nodes to set on the project tree, and make the settings with the Property panel.

See "2.3.3 Add a new subproject" and "2.4.2 Add an existing subproject", for how to add subproj-

Caution A subproject cannot be added to another subproject.
Remark
ects.
R20UT5134EJ0100 Rev.1.00 RENESAS
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2.3.1 Start a project

On the tool bar, click @ s to open the Start panel. You can click the buttons on the panel to create a new project or
open an existing one.
Note that the Start panel opens automatically the first time that CS+ starts.

Figure 2.5  Start Panel
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Number Description

M

See "2.3.2 Create a new project".

)

See "2.3.4 Create a project for multi-core [RH850]".
Note that this area is minimized by default; click to resize the area.

@)

See "(1) Open an existing project”.

(4)

See "2.4.10 Convert an e2 studio project into a CS+ project [RX][RL78]".
See "2.4.11 Convert a CubeSuite project into a CS+ project".

See "2.4.12 Convert a HEW project into a CS+ project”.

See "2.4.13 Convert a PM+ project into a CS+ project".
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2.3.2 Create a new project

This section describes how to create a new project.

Remark When a project for RH850 multi-core is created, see "2.3.4 Create a project for multi-core [RH850]".

From the [Project] menu, select [Create New Project...], the Create Project dialog box will open.

Figure 2.6  Create Project Dialog Box (When First Started)
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Set the items in the order below.

(1) Select the microcontroller type
Select the microcontroller type to use in the project on [Microcontroller].

You can select the item below.
- RH850

- RX

- RL78

(2) Select the microcontroller

Select the microcontroller to use in the project on the [Using microcontroller] area.
If your microcontroller is not in the [Using microcontroller] area, click the [Update...] button.

You can open the CS+ Update Manager window, and check for microcontroller information updates via the net-

work.

Caution The [Update...] button is only enabled when this product is installed using the installer. It is disabled

when a packaged item is being used.

(3) Select the project type
Select the project type to create on [Kind of project].
You can select the item below.

- Application(CC-RH/CC-RX/CC-RL)

R20UT5134EJ0100 Rev.1.00 ENESAS
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Select this to generate the load module file and hex file from C source files, by using the build tool provided by

CS+.

The generated file will be the debug target.

Caution This item is not displayed when microcontrollers for RH850 multi-core are selected in "(2) Select
the microcontroller”.
Remark 1. If the build tool is CC-RH, the following start-up source files are generated in the project folder.
These files are also registered in the project tree.
File Name Description
boot.asm For defining the processing from the occurrence of a reset to a branch to
the start-up routine and defining the interrupt vector table
cstart.asm For defining the start-up routine
iodefine.h For defining I/O registers
main.c For defining the empty main function
Remark 2. If the build tool is CC-RX, the following start-up source files are generated in the project folder.
The files marked with "OK" in the "Registration in Project Tree" column are also registered in the
project tree. When necessary, also register the files marked with "--" in the project tree.
File Name Description Registration in Project Tree
ProjectName.c For defining the main function OK
dbsct.c For setting up standard sections OK
hwsetup.c For initializing hardware -
intprg.c For defining interrupt functions OK
iodefine.h For defining I/O registers OK
lowlvl.src For defining low-level I/O functions (source --
file for assembler)
lowsrc.c For defining low-level I/O functions -
lowsrc.h Prototypes for low-level I/O functions --
resetprg.c For defining initialization for C language OK
sbrk.c For defining the function for allocating the OK
heap memory
sbrk.h For defining the heap size OK
stacksct.h For defining pragma for the stack OK
typedefine.h For defining typedefine for the types used in OK
sbrk.c, etc.
vect.h Prototypes for interrupt vector functions OK
vecttbl.c For defining the interrupt vector table OK
Remark 3. If the build tool is CC-RL, the following start-up source files are generated in the project folder.
These files are also registered in the project tree.
File Name Description
cstart.asm For defining the start-up routine from the occurrence of a reset to a

branch to the main function
The memory address and stack area need to be modified to match the
microcontroller used.
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File Name

Description

iodefine.h

For defining the names of I/O registers and interrupt requests

main.c

For defining the empty main function

- C++ Application(CC-RX)

Select this to generate the load module file and hex file from a C++ source file (only a file that has a main func-
tion) and C source files, by using build tool CC-RX provided by CS+.
The generated file will be the debug target.

Remark The following start-up source files are generated in the project folder.
The files marked with "OK" in the "Registration in Project Tree" column are also registered in the
project tree. When necessary, also register the files marked with "--" in the project tree.
File Name Description Registration in Project Tree
Project- For defining the main function OK
Name.cpp
dbsct.c For setting up standard sections OK
hwsetup.cpp For initializing hardware -
intprg.c For defining interrupt functions OK
iodefine.h For defining I/0O registers OK
lowlvl.src For defining low-level I/O functions (source file --
for assembler)
lowsrc.c For defining low-level I/O functions -
lowsrc.h Prototypes for low-level I/O functions --
resetprg.c For defining initialization for C language OK
sbrk.c For defining the function for allocating the OK
heap memory
sbrk.h For defining the heap size OK
stacksct.h For defining pragma for the stack OK
typedefine.h For defining typedefine for the types used in OK
sbrk.c, etc.
vect.h Prototypes for interrupt vector functions OK
vecttbl.c For defining the interrupt vector table OK

- Empty Application(CC-RH/CC-RX/CC-RL/GHS CCRH850)
Select this to generate the load module file, by using build tool CC-RH/CC-RX/CC-RL or build-tool plugin for

GHS CCRHB850 provided by CS+.

The generated file will be the debug target.
Sample startup programs are not generated when the project is created.

- Boot Loader for Multi-core(CC-RH)
Select this to create a boot loader project for multi-core, by using build tool CC-RH provided by CS+.
A boot loader project is used to set application projects configuring a project for multi-core.

Caution This item is displayed only when microcontrollers for RH850 multi-core are selected in "(2)
Select the microcontroller”.

Remark The following start-up source files are generated in the project folder.
These files are also registered in the project tree.

R20UT5134EJ0100 Rev.1.00
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File Name Description

bootn.asm For defining the processing from the occurrence of a reset to a branch to
each application project and defining the interrupt vector table

iodefine.h For defining I/0 registers

The core number n is sometimes included in the file name of a startup file (bootn.asm) for a core.

- Application for Multi-core(CC-RH)
Select this to create an application project for multi-core, by using build tool CC-RH provided by CS+.

Caution This item is displayed only when microcontrollers for RH850 multi-core are selected in "(2)
Select the microcontroller".
Remark The following start-up source files are generated in the project folder.
These files are also registered in the project tree.
File Name Description
cstartn.asm For defining the start-up routine for each application
iodefine.h For defining 1/O registers
main.c For defining the empty main function

The core number n is sometimes included in the file name of a startup file (cstartn.asm) for a
core.

- Using Existing GHS Project File(GHS CCRH850)
Select this to debug a load module file built by the GHS compiler.
This makes it easier to build based on existing GHS project files.

- Library(CC-RH/CC-RX/CC-RL/GHS CCRH850)
Select this to generate a library file for a user library, by using build tool CC-RH/CC-RX/CC-RL or build-tool plu-
gin for GHS CCRH850 provided by CS+.

- Debug Only
Select this to debug a load module file or hex file generated with a build tool other than the one provided by CS+
(i.e. creates a debug-dedicated project).
See "E. USING AN EXTERNAL BUILD TOOL" for details on how to create and use the debug-dedicated proj-
ect.

(4) Specify the project name and location to create the project file
Specify the name of the project and the location to create the project file in [Project name] and [Place].
If you don’t create a folder with the project name under the specified location, clear the [Make the project folder]
check box.

Caution 1.  When directly entering the location to create the project file, enter it as an absolute path.
Caution 2.  The name of a network path cannot be used for [Place]. Assign the name of a path on a drive.

Remark It is recommended to specify the same folder as the diverted project for the location to create the
project file.
If a folder different from the diverted project is specified, there is a possibility that path determina-
tion fails and a build error is occurred.

(5) Specify the reuse of the file structure of an existing project
When creating a project that reuses the file structure of an existing project, check [Pass the file composition of an
existing project to the new project] and specify the location of the project filename to reuse in [Project to be
passed].

Caution 1.  You cannot specify an e? studio, CubeSuite, High-performance Embedded Workshop, or PM+ proj-
ect file.
If you wish to copy an existing e? studio, CubeSuite, High-performance Embedded Workshop, or
PM+ project, open the project in CS+, then save it as a CS+ project (see "2.4.10 Convert an e2
studio project into a CS+ project [RX][RL78]", "2.4.11 Convert a CubeSuite project into a CS+ proj-
ect", "2.4.12 Convert a HEW project into a CS+ project”, "2.4.13 Convert a PM+ project into a CS+
project" for details). Next, specify the saved project file in this area.
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Caution 2.

Remark 1.

Remark 2.

When you create a project, only the settings for the default debug tool will be imported.
In the RX family, however, internal processing is common to the emulator and simulator, so the set-
tings are imported regardless of which debug tool is selected.

When the version of the build tool used in the source project is different from the version of the build
tool in the project to be created, it is automatically diverted (the case that "Debug Only" is specified
with [Kind of project] is excluded).

The settings of the properties of the build tool of the existing project are reused, then the properties
of the build tool are changed to those for the specified microcontroller. iodefine.h and the start-up
source files of the specified microcontroller are copied as sample source files. For the start-up files,
create a folder named "<device name after change>.nnn" (nnn = 000, 001, ...) and copy them to
that folder.

If you have selected a microcontroller that has a different ROM size from that set in the source
project, the differences between the ROM sizes may not be reflected in the value of the [Section
start address] property on the [Link Options] tabbed page. Check the value of the [Section start
address] property.

An image of the dialog box after setting the items is shown below.

Figure 2.7  Create Project Dialog Box (After Setting Items)
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When you click the [Create] button, the project file is created in the location specified in (4) and the structure of the cre-

ated project is displayed as a tree in the Project Tree panel.
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Figure 2.8  Project Tree Panel (After Creating a New Project)
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Remark

After creating a project, you must add target files to the project in order to perform building or debugging.
For details on how to add these files, see the following.

- When "Application" or "Library" is selected on [Kind of project]
-> See the "2.6.1 Add a file to a project"

- When "Debug Only" is selected on [Kind of project]
-> See "E.3 Add a File to a Project"
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2.3.3 Add a new subproject

Select the Project node on the project tree and if you select [Add] >> [Add New Subproject...] on the context menu, the
Create Project dialog box will open.

Figure 2.9  Create Project Dialog Box (When Adding a New Subproject)
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After setting each item on the dialog box, click the [Create] button (For more on the settings for each item, see "2.3.2

Create a new project").
You can create a subproject with CC-RL as the build tool by reusing the file structure of a subproject with

Remark
CA78KOR or CA78KO0 as the build tool (See "CS+ Integrated Development Environment User’s Manual:
Build Tool Operation" for details).

The project tree after adding the subproject will look like the one below.
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Figure 2.10 Project Tree Panel (After Adding a Subproject)
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2.3.4 Create a project for multi-core [RH850]

A project for multi-core consists of a boot loader project and an application project. The application project creates pro-

grams for each CPU core, and the boot loader project manages activation of those programs.

CS+ has a feature for creating the whole of a project with a default structure.
The way to use this is described below.

Remark Create a project in the usual way if you want to freely configure the whole of a project.

On the tool bar, click # == to open the Start panel.

Figure 2.11  Start Panel

Losiamh Abwimn G54

¥ W preresd read g e e h"r:m-ﬂ'\d £ b o2 5
. T bidorial pordarn B [-TF b (5

Ciriato Mierd PiTofaect

A e proyecd oo b crmsded
| GO A i pasyotd i bt be aiied by atuaing the B conipurshon rog oo b i e pepedd

(=]

Cireato Mo Mol core Projoeoi
& ey bl ke’ et b vl pin e s inbealn el o vl Broped G be droiied

GO Tl'-rh-cu I-:-e-am:--:-m:n:-h-:lm i oy ) e B vl (TS B Rt Eesiyicd e e 0 b 0 3 vt ch g

Oipan Existing Fropso
Leady B proyect ol S5 Car wiaz ba opess) crectl brom tha doflaaerg ko

Hepdhang Hipgrang

Th propect commied weth M2 U Sl sior Sindra el o oo, B obd 1DE con be coovermd o 5 peogact

Sipped werEon
PEm ey A1 e obe-{inlemn
Lal} Thee: eyt bl st by M L) Sirm gl o il s o i
15 Bl Al e il el s e i [t e L el

Opon Sampoe Projoct

Py 5 mphe pe ety ol dign by Badlimeredkdidy sepmmadel S spiecieg the deiand paped] b e bk beie, pams e G0 Bl
I

ity T e e Rt B ey Wt 2] el (o e
BN mm Ex

T e ]
w Fa-E80 FIE AESFALAS
FRER0FIL SasmwidsH
FRES0_ FIL_Tisceinl_drabas
FREEE0_FIL_Tuiwisl Bass Cosrsbon
oA Mo L1, Tutoesl_Base Cosson

Opan Existing MEU Senulalos Ordinads? studindCubsSuiloiHigh-peaformancs Embedded 'Workshep/PM+ Prajoct

R20UT5134EJ0100 Rev.1.00 ENESAS
Jun 01, 2022

Page 25 of 331



CS+V8.08.00 2. FUNCTIONS
Click the [GQ] button in the [Create New Multi-core Project] area to open the Create Project dialog box.
Remark The [Create New Multi-core Project] area is minimized by default; click |I| to resize the area.

Figure 2.12 Create Project Dialog Box (When First Started)
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Set the items in the order below.

(1) Confirm the microcontroller type
[RH850] is selected on [Microcontroller].

(2) Select the microcontroller

Select the microcontroller to use in the project on the [Using microcontroller] area.

If your microcontroller is not in the [Using microcontroller] area, click the [Update...] button.

You can open the CS+ Update Manager window, and check for microcontroller information updates via the net-
work.

Caution The [Update...] button is only enabled when this product is installed using the installer. It is disabled
when a packaged item is being used.

(3) Confirm the project type
[Boot Loader for Multi-core(CC-RH)] is selected on [Kind of project].

(4) Specify the project name and location to create the project file
Specify the name of the project and the location to create the project file in [Project name] and [Place].
If you don’t create a folder with the project name under the specified location, clear the [Make the project folder]
check box.
Caution 1.  When directly entering the location to create the project file, enter it as an absolute path.
Caution 2.  The name of a network path cannot be used for [Place]. Assign the name of a path on a drive.

(5) Specify simultaneous creation of a structure of startup files for each core
When simultaneously creating a structure of startup files for each core, select the [Create a structure of startup
files including main functions for each core.] check box.
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When the [Create a structure of startup files including main functions for each core.] check box has been selected,
select either of the following:

- Case where a structure of startup files for each core is created as an application project for the number of cores
Select [Create them as application projects].

- Case where a single project that includes structures of all startup files is created
Select [Create them as a single project].

An image of the dialog box after setting the items is shown below.

Figure 2.13 Create Project Dialog Box (After Setting ltems)

)

Create Project

il

Microoongrolle: RHEED

Wning microcontnol ler

3, [Search microcontroller Lipdats. _I
[ % AHERAEH Preaduc! Mame 777 T0M201 A
| 5 Wy RHESOEIL Iniemal FOM sipa[KiDdes]:
0 R Rl | Sode Pa 248 |
W RIFD2EEGAROFPTISTRP || e RN sanfBries =|
| i W AHESOEIM-5 Lozal FLAMC® L 451
| Ty AHEAOE 1. FCCT wmﬂm
| o i g Shobal y
| & %y AHESOCIH i el
[« i b | | Addtinal Infomstion Burber of Coma: 2 -
Kind of project Bt Loadar for Myli-core{CC-AH) |l
Prejisct e ST el

Flace: O fort s ampd e F m
| Mk b propect Fddis

Ocidorilaamplets ample_muhsample_molt min)

7 Crgate a stroctis of statug fies inchuding man donctiana for sach oo

& Cowoie Them sz applcation projecis
o Than &b B argia Brighs)

[ et || Coed || b |

When you click the [Create] button, the project file is created in the location specified in (4) and the structure of the cre-
ated project is displayed as a tree in the Project Tree panel.
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Figure 2.14 Project Tree Panel (After Creating a New Project)
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Boot loader project

Application project

Application project

The start-up source files for each project are also created in the project folder and registered in the project tree.

(1)

)

(a)

(b)

When [Create a structure of startup files including main functions for each core.] check box is not selected

File Name Description
bootn.asmN°ote For defining the processing from the occurrence of a reset to a branch to each applica-
tion project and defining the interrupt vector table
iodefine.h For defining I/O registers

Note

The core number n is sometimes included in the file name of a startup file for a core.

When [Create a structure of startup files including main functions for each core.] check box and [Create them as
application projects] radio button are selected

Start-up source files for the boot loader project

File Name Description
bootn.asmNote For defining the processing from the occurrence of a reset to a branch to each applica-
tion project and defining the interrupt vector table
iodefine.h For defining I/O registers

Start-up source files for the application project

File Name

Description

cstartn.asmNote

For defining the start-up routine for each application
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File Name Description
iodefine.h For defining I/O registers
mainn.cNote For defining the empty main function

Note The core number n is sometimes included in the file name of a startup file for a core.

(3) When [Create a structure of startup files including main functions for each core.] check box and [Create them as a
single project] radio button are selected

File Name Description
boot.asm For defining the processing from the occurrence of a reset to a branch to each applica-
tion project and defining the interrupt vector table

cstartn.asmNote For defining the start-up routine for each application

iodefine.h For defining I/0 registers

mainn.cNote For defining the empty main function

Note The core number n is sometimes included in the file name of a startup file for a core.

Remark 1. The application project name is “boot-loader-project-name_App1”.

Remark 2. Add further application projects as subprojects.
See "2.3.3 Add a new subproject" and "2.4.2 Add an existing subproject”, for how to add subprojects.
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2.4 Manipulate a Project

This section describes how to manipulate a project.

2.4.1 Open a project

Use the following method to open a project.
- Open an existing project

- Open a recently used project

- Open a project from the favorites menu

(1) Open an existing project
Existing projects are opened by specifying the project file.
From the [Project] menu, select [Open Project...], the Open Project dialog box will open.

Figure 2.15 Open Project Dialog Box
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On the dialog box, specify the project file and click the [Open] button.

Remark When CS+ is not running, you can start CS+ and load a project by double-clicking on that project in
Explorer.
Caution The name of a network path cannot be used. Assign the name of a path on a drive.

(2) Open a recently used project

You can directly open the most recently used projects (from the most recent to the fourth most recent) from the
menu.

From the [File] menu, select [Recent Projects], the path of the recently used projects will display in a cascading
menu in order from most recent to fourth most recent. Select the project you wish to open.

Figure 2.16 [Recent Projects] ltem

Recent Projects 3 ﬁ 1 C:workisampled4 | sample04.mtpj .
i 2 Crhwork\sampled2\sampled3.mip]
i 3 Chwork'\sampled2\sampled2.mip
1 4 C:\work\sample\sampletp]
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(3) Open a project from the favorites menu
Open a project registered on the favorites menu.
From the [Project] menu, select [Favorite Projects], the path of the projects registered on the favorites menu is dis-
played as a cascading menu. Select the project you wish to open.

Figure 2.17 [Favorite Projects] Item
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2.4.2 Add an existing subproject

Select the Project node on the project tree and if you select [Add] >> [Add Subproject...] on the context menu, the Add
Existing Subproject dialog box will open.

Figure 2.18 Add Existing Subproject Dialog Box

i Add Bdsting Subproject =
@C}'l .+ wark [} HITIDlE * sub » = | h? Il =
L

Drganiza - Febarwy Fodiar

. Windires g CefaultBuild
work | Eub. ks
sample
. DefauitEulld
. Sub
Users
B# Local Disk (C:)
& Local Disk (O]

File name: sub.misp - [Sul.:p:ujr.‘ct File {*.mitsp} -

| Cpan 'JI Caneel

On the dialog box, specify the subproject file of the subproject to add and click the [Open] button.

2.4.3 Project is added to the favorites menu

You can add the currently open project to the menu as a "favorite project" (up to four projects).

From the [Project] menu, select [Favorite Projects] >> [1 - 4 Register to Favorite Project], the path of the currently open
project is registered under the [Project] menu >> [Favorite Projects]. The path is also registered in [Favorite project] in the
[Open Existing Project] area on the Start panel.
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Figure 2.19 [Register to Favorite Project] Item
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Figure 2.20 [Favorite Projects] Item (After Registering a Project)
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2.4.4 Remove a subproject from the project

To remove a subproject registered to a project from that project, select the Subproject node on the project tree, and
select [Remove from Project] on the context menu.
In addition, the subproject file itself is not deleted from the file system.

Figure 2.21 [Remove from Project] Item
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2.4.5 Change the project name

You can change the name of the project (main project or subproject) on the project tree.

Select the Project node or Subproject node and select [Rename] on the context menu.

Figure 2.22 [Rename] Item (For a Project)
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Remark After changing the project name, when you save the project, the actual name of the project file is also

changed.

2.4.6 Open a project folder in Explorer

You can open the folder where the project file for a project (main project or subproject) is saved from the project tree in

Explorer.

Select the Project node or Subproject node and select [Open Folder with Explorer] on the context menu.

Figure 2.23 [Open Folder with Explorer] ltem (For a Project)
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Remark When you select [Open Folder with Explorer] from a file's context menu, the folder the file is saved in is
opened in Explorer.
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2.4.7 Set the build order of projects

Builds are run in the order of subproject, main project, but when there are multiple subprojects added, the build order of
subprojects is their display order on the project tree.

To change the display order of the subprojects on the project tree, drag the subproject to be moved and drop it on the
desired location.

However, when dependent projects have been set, builds of those projects are run first.
Dependent projects are set in the Dependent Projects Settings dialog box which is opened by selecting the [Project]
menu >> [Dependent Projects Settings...].

Figure 2.24 Dependent Projects Settings Dialog Box
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Select the dependent-source project in [Project], select a project to be referenced as the dependent project from a
check box in [Dependent projects], and click the [OK] button.

Remark 1. By default, an active project is selected in [Project].
Remark 2. A cyclic-reference project is displayed in gray in [Dependent projects].

Example 1.  Builds are run in the following order when no dependent project is set.
SubProject1 -> SubProject2 -> SubProject3 -> SubProject4 -> MainProject

MainProject
— SubProject1
— SubProject2

— SubProject3

— SubProject4

Example 2.  Builds are run in the following order when MainProject and SubProject2 are set as dependent projects for
SubProject1 and SubProject4 is set as the dependent project for SubProject2.
SubProject4 -> SubProject2 -> MainProject -> SubProject1 -> SubProject3
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MainProject# - - - - - 1

— SubProject1[ ZZ 21
I Reference
— SubProject2 <-- :

— SubProject3 Reference

'— SubProject4 4 - - 4

2.4.8 Open a CubeSuite+ project

A CubeSuite+ project whose build tool is lower than CC-RX V2.02.00 or lower than CC-RH V1.01.00 can also be
opened from CS+ with the following method.

(1) Install the compiler package
Copy the compiler folder of the relevant version from the CubeSuite+ installation folder and paste it to the CS+
installation folder.

Copy from: CubeSuite+ install folder\ CubeSuite+\ CC-XX\Vx.xx
Paste to: CS+ install folder\ CC\CC-XX

Caution This operation must be conducted with administrator privileges of Windows.

(2) Open the CubeSuite+ project
Select [Open Project...] from the [Project] menu with CS+, and then select a CubeSuite+ project file (see "(1)
Open an existing project”).

(3) Set the version of the compiler package
Select the target version in the [Using compiler package version] property of the build tool (see "2.5 Change the
Build Tool Version").

Caution When the compiler package is installed with the above method, it cannot be uninstalled by the integrated
uninstaller. Delete all copied folders from Explorer, etc. to uninstall the compiler package.
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2.4.9 Convert a CA78KO0R or CA78KO0 project into a CC-RL project

A project for the CA78KOR or CA78K0 compiler created by using CS+ or CubeSuite+ can be converted into a project for
the CC-RL compiler. Make use of the existing file configuration to create a new project for the CC-RL compiler.
When creating the project, it is not necessary to code build-tool dependent source, because the source files are con-

verted for the CC-RL.

The properties of the build tool are also maintained, and converted for use with the CC-RL.

Caution 1.  See "2.4.13 Convert a PM+ project into a CS+ project" about converting a PM+ project into a CS+ proj-

ect.

Caution 2.  In converting projects created by using CA78KOR or CA78KO0 to projects for use with CC-RL, conversion
will not proceed if the destination folder already contains files with the same names as those of the files to
be output. Check that there are no such files in the destination folder before using the converter.

First, from the [Project] menu, select [Create New Project...], the Create Project dialog box will open.

Figure 2.25 Create Project Dialog Box

Create Prafect

Microcony o s RLT2
Uming microcosincller
B, [Search microcomroller Lipate

¥ ALTAG1S (ROM43KE) + | [ Preduct Name RSFII2E

Wy ALTEG S (FRIOM:B4KE) intemal ROM size(HEytes] 64
i FFI00EE 0 irtemal RAM sz |Bites] 4096
@ FEF01BER0gin

REF MOTE 24gin]

l. FEF IO CE 240

W FEFT00RE[250in)

i _JF=FI0IBEEgin) :

T T T

Kind of project Applicabon{CC-AL)
Prejiest paims FF e
Place: Drwerk

W] Make iha project llder

O rascric seamipd &' veple. il
Pags (b By compadibsn of Bn s ling peopsct 19 e iy propect
I T EC ] 00 o2 3550

Lofs' comnposion ke it divered projech solder o @ nes project kolder

| Create | | Cancal

e

Set the items in the order below and click the [Create] button.

(1) Select the microcontroller type
Select "RL78" on [Microcontroller].

(2) Select the microcontroller

Select the microcontroller to use in the project on [Using microcontroller].

(3) Select the project type

Under [Kind of project], select "Empty Application(CC-RL)" or "Library(CC-RL)", in accordance with the source

project.
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(4) Specify the project name and location to create the project file
Specify the name of the project and the location to create the project file in [Project name] and [Place].
If you don’t create a folder with the project name under the specified location, clear the [Make the project folder]

check box.

Remark It is recommended to specify the same folder as the diverted project for the location to create the
project file.
If a folder different from the diverted project is specified, there is a possibility that path determina-
tion fails and a build error is occurred.

Caution The name of a network path cannot be used for [Place]. Assign the name of a path on a drive.

(5) Specify the reuse of a CA78KOR or CA78K0 project
Check [Pass the file composition of an existing project to the new project] and specify the location of the project
filename to reuse in [Project to be passed].

Click the [Create] button. The Source Convert Setting dialog box [CC-RL] appears.

Figure 2.26 Source Convert Setting Dialog Box

Source Convert Settings [a]

o cam corvert the progect composition files lke source files dor She build tool of She
N oo,

Do wois really want 10 consen solnce [les?
= (0riginal souros files o cwernitien by comersion.

& ez
[

Bachup of props belore oo ion

o | Backup tha propel compagilion liks bedora corarzion

Pl [ ¥l Dok | Ercmeri

T — | -

Select [Yes] to perform conversion on the source files.

To save a backup of the entire project (including source files), select the [Backup the project composition files before
conversion] check box, and specify a location in which to save the backup.

Click the [OK] button to convert the source files and create the CC-RL project.

Remark The result that a CC-RL project is created by reusing a CA78KOR or CA78KO0 project (the versions of the

IDE and compiler package, and conversion information of options) is output to a file as project divert
information.

- The project divert information file name is "ProjectDivertinformationn.ixt" (n = 2 to 100).
nis not added normally. It is added if the file to be created already exist.

- The project divert information file is output for each created project (subproject).
- The project divert information file is output to the project folder of the project (subproject).

- The project divert information file is added to the File node of the project (subproject) on the Project
Tree panel.

The output format of the project divert information file is shown below.
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(1) Time and date on which a project was created

(2)<CS+ IDE (Integrated Development Environment Framework) version>
CS+ IDE: Version of IDE of CA78KOR or CA78K0 project -> Version of IDE
of CC-RL project

(3)<Compiler package version>
CA78KOR: Version -> CC-RL: Version

(4)<Options not to use(Build mode)>
Command name (Tab name of build tool property)
Option

(5)<Options to change (Build mode) >
Command name (Tab name of build tool property)
Option of CA78KOR project -> Optio